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A PLC-t (Progamable Logic Controller- Programozható Logikai Vezérlő) az iparban már régóta alkalmazzák, mint megbízható vezérlőt. Ezeket a vezérlőket inkább irodaházakban, bevásárló központokban, gyárakban alkalmazzák. Ezekkel a vezérlőkkel oldják meg a légtechnikát, hűtés-fűtésvezérlést, tűzvédelmet, gyártósorvezérlést stb..
Szakdolgozatomban, a hétköznapi életben való felhasználását szeretném bemutatni, mint például a kerti világításnál, hűtés-fűtésnél, beltéri világításnál, árnyékolásnál stb. Ezzel az eszközzel szinte mindent vezérelni tudunk a háztartásunkban, csak a pénztárcánk szab határt. 
Pénztárca! Ha már itt tartokunk, megemlítem, hogy ez a berendezés lényegesebben olcsóbb, mint a piacon lévő más épületvezérlők (EIB-KNX), de ugyanakkor a PLC megvalósítása kissé kötöttebb. Az első megvalósítás ugyanúgy történik, mint bármely épületvezérlőnél, de bővítés esetén már lényegesen nehezebb megoldani a feladatot. 
Mivel a PLC felépítéséből adódik, hogy egy központi egysége van, ezért az összes érzékelőt, beavatkozót hozzá kell csatlakoztatni és ez bővítésnél akár falbontást is eredményezhet az épületben. Más épületvezérlőknél ezt úgy oldották meg, hogy az érzékelőket és beavatkozókat egy soros buszra fűzték fel, így bővítésnél csak a buszhoz kell csatlakozni. Mindkét megoldási módnál van lehetőség internethez való csatlakozásra, amin keresztül szintúgy tudjuk vezérelni otthonunkat.
	Azért érdemes a PLC-vel foglalkozni a háztartásokban is, mert a telepítése ugyanakkora munkával jár, mint más épületvezérlőknél, ugyanakkor az ára ötödannyi! Ha feláldozzuk azt a jogunkat, hogy kényünk kedve szerint változtatjuk a rendszert és esetleg előrelátóan a bővítéseket is megtervezzük (falban lévő vezetékek kiépítése), akkor érdemes ezt a fajta épületautomatika módot választani!
Szakdolgozatom célja, hogy bemutassam lépésről lépésre a háztartásban lévő PLC telepítését és annak programozását valamint bizonyítani szeretném, hogy erős helye van a háztartásokban. 
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A programozható vezérlők (Programmable Logic Controller, Programozható Logikai Vezérlő) az 1970-es évektől kezdődően terjedtek el és ma csaknem kizárólagos alkalmazást nyertek el az ipari folyamatok vezérlésében. A programozható vezérlőberendezések, a vezérlési (esetleg szabályozási) funkciókat szoftver útján valósítják meg és beviteli, kiviteli egységeik révén a technológiai folyamatok tárolt programú vezérlésére közvetlenül alkalmasak. 
1968-ban a General Motors cég pályázatot hirdetett olyan programozható vezérlőberendezés fejlesztésére, amely ötvözi a relés, a félvezetős és a számítógépes vezérlés előnyeit. 
A pályázat specifikációjában az alábbi szempontok szerepeltek:
• Egyszerű, moduláris felépítés, kis méret
• Mozgó alkatrészt ne tartalmazzon
• Galvanikusan leválasztott bemeneti/kimeneti fokozatok
• Könnyű programozhatóság és újraprogramozás
• Valós idejű működés max. 0,1 s válaszidővel
• Nagy megbízhatóság, minimális karbantartás
• Versenyképes ár
A mai PLC-ket kivitelük alapján kompakt és moduláris felépítésű csoportba sorolhatjuk. A kompakt PLC jellemzője, hogy hardverstruktúrája nem módosítható, kizárólag megfelelő védettségű ipari tokozásban készül és kis helyigényű. Felhasználási területei a sorozatban gyártott gépek, berendezések automatikái, illetve a PLC műszaki jellemzői által lefedhető egyedi vezérlések. A kompakt PLC-k speciális típusát jelentik az ún. mikro-PLC-k, amelyek az ember-gép kapcsolat hardver- és szoftverfeltételét is tartalmazzák.
A moduláris felépítésű programozható logikai vezérlők jellemzője, hogy a vezérlőberendezés valamely speciális funkciót önmagában ellátó modulokból épül fel. A modulok fizikai megjelenése rendszerint az áramköri kártya dugaszolható csatlakozóval. A modulok ún. rack-be (tartó) dugaszolhatók, ezért a rendszer konfigurációja tág határokon belül bővíthető. A rack-ek megfelelő védettségű műszerdobozba, vagy műszerszekrénybe szerelhetők. A moduláris felépítésű PLC-ket közepes, ill. nagyméretű rugalmas gyártórendszerek, vagy ipari folyamatok irányítására fejlesztették ki.
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Egy PLC - legyen kompakt vagy moduláris - a következő alapvető elemekből épül fel:
• Központi logikai, ill. feldolgozóegység(CPU)
• Programmemória (ROM, EPROM, EEROM)
• Adatmemória (RAM)
• Bemeneti (input) egységek (digitális, ill. analóg)
• Kimeneti (output) egységek (digitális, ill. analóg)
• Kommunikációs egység
• Tápegység
Ezek összeköttetését a PLC busz biztosítja. Most egy moduláris PLC darabjait vesszük sorra a 2.1-es ábrán.
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2.1. ábra. A PLC funkcionális felépítése
CPU modul
A  CPU modul a PLC központi egysége, amely a logikai számításokat végzi és az utasításokat hajtja végre: futtatja a memóriájában elraktározott programot és vezérli a többi alkotóelemet.
Általában található rajta valamilyen kommunikációs port, amely többek között a számítógépes programozást, kijelzők, terminálok csatlakoztatását teszi lehetővé. Ez legtöbb esetben RS232, RS422, RS485, vagy valamilyen saját interfész szokott lenni. Az egység tartalmaz még egy RAM vagy EPROM memóriát is, amiben a program tárolódik. Régebben voltak huzalozással programozható egységek is, de ezeket nehézkes kezelésük miatt ma már nem alkalmazzák.
A nagyobb központi egységek tartalmaznak még egy rádióvevő egységet is, amely a gyártó adójára van hangolva. Ez az adó a mindenkori pontos időt sugározza és nagyban megkönnyíti az egymástól nagy távolságban levő PLC-k szinkronizálását.
Tápegység
Ez a modul szolgáltatja a PLC moduljainak az áramellátást. A RAM memóriát tartalmazó CPU-khoz általában akkut is tartalmazó tápegységeket választanak, hogy a program áramszünet esetén is megmaradjon.
I/O egységek
Ezek az egységek skálázzák, alakítják a bemenő jeleket a CPU számára elfogadhatóvá, a kimenő jeleket pedig az ipari feszültségekhez illesztik. Ezek lehetnek digitális vagy analóg egységek. A digitális egységek kimeneteire vagy kapcsol feszültséget, vagy nem. Ez történhet relékkel, vagy félvezetőkkel. A relék előnye a félvezetős megoldással szemben, hogy nagy áramok kapcsolásához is olcsó megoldást nyújtanak, de nem túl gyorsak. A legnagyobb relékkel elérhető kapcsolási frekvencia 10 Hz körül mozog, ezzel szemben a félvezetős megoldások kapcsolási frekvenciája akár 100 Hz fölé is mehet. Azonban ha ezekkel nagy feszültségeket szeretnénk kapcsolni, azt már csak eléggé drágán tehetjük meg.
A digitális egységek ki/bemenetein általában 24, 48, 60, 220 V= feszültséget tudnak fogadni vagy kapcsolni. Vannak olyan egységek is, amelyek képesek váltakozó áramot is fogadni, vagy kapcsolni. Az analóg I/O egységekben A/D és D/A átalakítók vannak. Ezek a bejövő feszültségeket digitális jelekké, vagy a digitális kimenő jeleket analóggá alakítják.
Kommunikációs egységek
Ezek biztosítják a kommunikációt további PLC-kkel, vagy terminálokkal, PC-kel. A PLC-k és a számítógépek összekötésére az egyik szabvány a DeviceNet, ami szerint minden PC-t és PLC-t egy Ethernethez hasonló sínre tesznek, majd ezek így tudnak egymással kommunikálni. Ennek a rendszernek az az előnye, hogy a PLC-k programozása és a beavatkozás sokkal egyszerűbbé válik és a huzalozás költségei is csökkennek. Néhány PLC csatlakoztatható az Internetre is, így a programozó akár otthonról is rá tudja tölteni a kívánt programokat, vagy nagy távolságokra levő PLC-k is tudnak egymással kommunikálni külön kommunikációs vonal lefektetése nélkül is.
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A programozható vezérlők üzemszerűen számos információforrással állnak kapcsolatban. A leggyakrabban a PLC és a technológiai folyamat, PLC és PLC, PLC és számítógép, PLC és kezelő, valamint PLC és periféria közötti kommunikációra van igény. A PLC és a technológiai folyamat közötti kommunikáció általában párhuzamos formában zajlik, kivéve a terepi buszrendszerek által kezelt be- és kimeneteket.
A párhuzamosan kezelt jelek lehetnek:
• Kétállapotú be/kimenetek
• Analóg be/kimenetek
• Frekvencia (impulzus) be/kimenetek
A PLC és PLC, PLC és PC, PLC és kezelő, valamint PLC és periféria közötti kommunikáció rendszerint soros formában történik. Soros adatátvitel esetén az adatok bitenként, a kiegészítő, ellenőrző jelekkel együtt, időben egymás után rendszerint egy vezetéken (érpáron) kerülnek továbbításra. Az információt a feszültség, vagy az áram szintje, ill. jelátmenete képviselheti. A 2.2 ábra szerinti soros adatátvitelnél a 0 szintet 0 V, az 1 szintet 6 V képviseli, amely min. egy bitideig tart. A soros átvitelnek számos jellemzője és szabványa van (RS 232, RS 485, stb.).

[image: 7%20abra]
2.2.ábra:Soros adatátvitel formátum

Soros adatátvitel a kommunikációban részt vevő adók és vevők számától függően alapvetően két pont között (pont-pont kommunikáció), ill. több pont között történhet. Pont-pont közötti kommunikáció esetén két egység között folyik az adatátvitel egy vagy mindkét irányban. A több pont közötti (multi-point) kommunikáció napjainkban szinte kizárólag hálózati jellegű, amely jellemzője, hogy kettőnél több egység (adó, ill. vevő) között egy speciális architektúrájú átviteli közegen keresztül történik az adatátvitel. A jelenlegi informatikai hálózatok a hálózat által áthidalt távolságok alapján távolsági hálózatokra, ill. lokális hálózatokra bontható.
A távolsági hálózatok (Wide Area Network, WAN) rendszerint a nyilvános távközlési berendezéseket veszik igénybe és nagy távolságú, földrészek közötti kommunikációt valósítanak meg. A lokális hálózatok (LAN) kis és közepes kiterjedésű földrajzi területen elhelyezkedő, független eszközök közötti egyenrangú kommunikációt valósítanak meg. A hálózati elemeket három csoportba sorolhatjuk: a kommunikációs állomásokra, az állomásokat összekapcsoló kábelrendszerre és a kiegészítő hálózati elemekre. A hálózati állomásoknak megfelelően intelligens szoftverrel kell rendelkezniük ahhoz, hogy kezelni tudják a hálózat számára szükséges kommunikációs és vezérlési funkciókat.
A soros kommunikáció jelentősége napjainkban felértékelődik. A PLC programjának jelentős részét a kommunikációra vonatkozó programrész teszi ki, amely elkészítése a konkrét PLC hardver- és szoftveradottságain túl sokrétű, a kommunikációra vonatkozó általános és specifikus informatikai ismereteket igényel. A 2.3 ábrán a PLC-k alkalmazása látható többszintű informatikai rendszerben.
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2.3 ábra. PLC-k többszintű informatikai rendszerben
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Bár a pont-pont közötti kommunikációnak vannak tipikus alkalmazási területei, napjainkban a több pont közötti kommunikáció igénye növekszik.
Több PLC közötti kommunikáció módszerei a következők:
• Több soros vonal révén kialakított pont-pont kapcsolat (2.4.a ábra)
• PLC- hálózat (2.4.b ábra)
• ETHERNET- hálózat (2.4.c ábra)
• Adatgyűjtő számítógép
A 2.4.a ábra szerinti megoldás korlátozott kommunikációra alkalmas. Ezért látják el a PLC-ket egynél több RS 232C szabványú illesztőegységgel. A megoldás hátránya az alacsony átviteli sebesség és a kis távolság.
A 2.4.b ábrán látható PLC- hálózat a leggyakoribb kommunikációs módszer a több PLC közötti információs kapcsolat kialakításához.
Tekintettel az ETHERNET- hálózat (és ezen keresztül az Internet) világméretű elterjedésére és az ebből eredő előnyökre, különösen a nagy távolságú, ill. nagy adatmennyiségeket igénylő kommunikáció esetén célszerű alkalmazni (2.4.c ábra). Minden perspektivikus PLC-nek van ETHERNET hálózati csatolója.
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2.4 ábra:Több PLC közötti kommunikáció lehetőség

Az irányítástechnika kommunikációs hálózatainak előnyei:
• Jelentősen kisebb kábelköltségek
• Kisebb méretű kapcsolószekrények
• Kisebb mennyiségű járulékos, hagyományos technika
• Kisebb telepítési és ráfordítási költségek
• Kisebb szervizköltségek
• Nagyobb üzembiztonság és teljesítmény
• Rugalmas módosítási lehetőség
A PLC rendszer ETHERNET- hálózatának alkalmazási példái:
• Távprogramozás és monitorozás
• Mail- szolgáltatás pl.: a PLC e-mail üzenetet küld hiba detektálásakor
• PLC-PLC közötti üzenetváltás
• Fájlátvitel valósítható meg a PLC- memória és a PC memóriája között
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A PLC-k programozására számos módszer létezik, de elviekben ezek nagyon hasonlítanak egymáshoz. A legegyszerűbb módszer, amit általában kompakt PLC-ken alkalmaznak, hogy a PLC-n található gombok és kijelző segítségével egyszerű programokat vihetünk be minden egyéb eszköz nélkül. Ez a megoldás remekül működik kisebb programoknál, ám nagyobb feladatok programozásához nehézkes és nagy a hibalehetőség. A moduláris PLC-ket általában nem látják el külön kezelőszervekkel, hanem a programot PC-n fejlesztik, majd megfelelő adatkábel segítségével töltik át a PLC-re. Ezek a programok általában képesek valamilyen szinten szimulálni a PLC működését, így a programok tesztelése már a PC-n megtörténhet. A különböző szakemberek különböző szemléletmódjaihoz is igazodtak a fejlesztőszoftverek, több különböző programmegjelenítés is lehetséges.
Szöveges / utasításlistás
A szöveges megjelenítési mód hasonlít leginkább a hagyományos PC-s programnyelvekre. Ez azonban nem annyira áttekinthető, mint a grafikus módok. A lényege, hogy különböző a gép által érthető „mondatokkal” adjuk meg, hogy mit is csináljon majd a PLC. Ezeket a mondatokat a fordítóprogram lefordítja a PLC számára érthető programnyelvre, majd áttölthetjük azt a PLC programtárába.
Blokkdiagram
Ez az ábrázolási mód grafikus, inkább a villamosmérnökök számára átlátható. Hasonlít egy rendes áramköri rajzhoz. A programozó a képernyőre rajzolhatja a logikai kapukat, logikai egységeket, időzítőket, egyéb alkotóelemeket. Ezeket összekötve áramkörként definiálhatja a programot. Másik lehetőség, hogy az áramkör nem logikai egységekből épül fel, hanem virtuális reléket, tekercseket köthet össze a fejlesztő.
Létradiagram
Ez a másik alapvető grafikus programozási módszer, amely az információtechnológiában járatos emberek számára nyújt könnyű áttekinthetőséget. Itt egy sínre illeszthetünk bizonyos feltételekhez kötött utasításokat. A PLC minden időpontban megvizsgálja, hogy mely feltételek teljesülnek, és az azokhoz tartozó utasításokat elkezdi végrehajtani.
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A bemutatásra kapott PLC-t a Wago Kft. biztosította számomra. E cég a CoDeSys nevezetű programot használja a vezérlői felprogramozására. A CoDeSys egy komplett fejlesztői környezetet biztosít PLC-k programozásához, amelyet több cég is használ a PLC-i programozásához. Különbségek abból adódhatnak az egyes szoftver-installációk között, hogy különböző célhardverek vannak mellé telepítve.
Minimális rendszerigény:
600 MHz CPU sebesség; 128 MB RAM; kb. 200 MB szabad HDD terület
Windows NT 4.0 SP6 / 2000 SP3 / XP SP1 operációs rendszer
VGA grafikus kártya, True Color mód ajánlott; 800x600 képernyőfelbontás
CD-ROM meghajtó; Microsoft Internet Explorer 5.x
 A program feltelepítése igen egyszerű. Kezdésnek a Setup.exe file-t kell elindítani. Ekkor ki kell választanunk a program nyelvét, amit én angolnak választottam.
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3.1 ábra: A nyelv kiválasztása

Ezután egy olyan ablak ugrik fel, amiben a program azt kéri, hogy minden olyan alkalmazást zárjunk be, ami zavarhatná a telepítést.

[image: ]
3.2 ábra: Felszólítás a futó programok bezárására
Majd kezdetét veszi a telepítési beállítások.
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3.3 ábra: Telepítés kezdete
A „Next” gombbal ugorjuk tovább az ablakot, majd fogadjuk el a szerződési feltételeket!
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3.4 ábra: A szerződési feltételek elfogadása
Ezután válasszuk ki, hogy hová szeretnénk a programot feltelepíteni!
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3.5 ábra: A program telepítési helyének kiválasztása
Majd egy olyan ablak ugrik elő, melyben a különböző komponenseket kell kiválasztanunk! A program felajánlja az optimális beállítást, amelyet célszerűségi okokból fogadunk el.
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3.6 ábra: A komponensek beállítsa
Ezután a program nevét kell megadunk a program mappákban.
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3.7 ábra: A program mappájának megnevezése
A program ezután egy telepítési áttekintőt jelenít meg számunkra.
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3.8 ábra: Telepítési áttekintő
Ezt követően a program megkezdi a telepítést.
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3.9 ábra: A telepítés
A telepítés végeztével kattintsunk a „Finish” gombra!


[bookmark: _Toc281762944]A PROGRAM ELSŐ LÉPÉSEI [3]

[bookmark: _Toc281762945]A CoDeSys indítása
A CoDeSys programcsomag a Start menü→Programok→WAGO Software→CoDeSys V2.3→CoDeSys V2.3 ikonra való kattintással indítható.
Az inicializálási eljárás után a CoDeSys navigátora lesz látható, amelyben megnyithat, illetve létrehozhat egy projektet.
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4.1 ábra: A CoDeSys navigátora indítás után

[bookmark: _Toc281762946]Új projekt létrehozása
A programozás megkezdéséhez először egy projektet kell létrehozni, amelyben a program- és adatstruktúra elkészíthető és tárolható.
Ehhez válasszuk a menüből a „File -> New” parancsot.
[bookmark: _Toc281762947]Központi egység kiválasztása
A megjelenő párbeszédablakban először válasszuk ki azt a központi egységet, amelyre a programot el szeretnénk készíteni. „None” választása csak szimulációhoz ajánlott.
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4.2 ábra: A központi egység kiválasztása
Ha sikerült a megfelelő célhardvert kiválasztani, továbbléphetünk a paraméterek beállítására.

[bookmark: _Toc281762948]Paraméterek beállítása
Állítsa be a járulékos tulajdonságokat, amennyiben szükséges.
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4.3. ábra: Paraméterek beállítása

[bookmark: _Toc281762949]A programozási nyelv kiválasztása a főprogramhoz
A főprogram neve „PLC_PRG” -ként előre definiált, ezen ne változtassunk! Válasszuk ki a projekthez leginkább alkalmas nyelvet, illetve amelyben a főprogramot szeretnénk írni. A többi funkciót a 6.1.2-ben ismertetem.
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4.4 ábra: A programozási nyelv kiválasztása
[bookmark: _Toc281762950]PLC konfiguráció
A PLC konfigurációban a programozó leírja az automatizálási rendszer hardver elemeit, beleértve a támogatott terepi buszrendszerekbe bekötött decentralizált komponenseket is. Ehhez válasszuk a „Resources” lapon a „PLC Configuration” pontot. Ezután lépésről lépésre konfigurálhatjuk a hardver felépítés összes elemét, ideértve a lokális I/O-kat, a CANopen és a Profibus DP hálózatokra csatolt decentrális I/O-kat, az összes kommunikációs paramétert, az Ethernettel együtt. A konfigurátor az I/O modulokhoz a fizikai címeket az CoDeSys-ba történő beszúrás sorrendjében rendeli hozzá. Új elemet az „Insert → Append Subelement”, vagy az „Insert Element” menüpont alatti listából kiválasztva lehet beszúrni, majd az elemre kattintva a jobb oldalon megjelenő ablakban állíthatóak be a hozzá tartozó paraméterek.
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4.5 ábra: A hardver felépítés konfigurálása


A hardverek címét is meg lehet változtatni, ha a „AT %”-ra duplán kattintunk és így a programban könnyebben tudunk címezni.
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4.6 ábra: A hardver címének konfigurálása

[bookmark: _Toc281762951]Projekt mentése
A mentéshez válasszuk a menüből a „File→Save” parancsot. Adjuk meg a projekt nevét, mely „.pro” kiterjesztéssel kerül elmentésre. Ez a fájl tartalmazni fogja az összes felhasználói adatot, programot, konfigurációt. A program írása során érdemes többször is menteni az aktuális állapotot.
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4.7 ábra: A projekt mentése



[bookmark: _Toc281762952]A PROGRAM RÖVID BEMUTATÁSA [3]

[bookmark: _Toc281762953]A főablak felépítése
A projekt létrehozása után láthatjuk, hogy a főablak négy részre van felosztva. Baloldalt található az „Object Organiser” mező, amely a következő négy lapból áll: POUs, Data types, Visualisations, Resources. Ezeken a projektben lévő alprogramokról, adattípusokról, vizualizációkról és a projekttel kapcsolatos beállításokról lehet információt kapni. A lapok között az alul található fülekre való kattintással lehet váltani. Jobb oldalt pedig a munkaterület látható: felül a változó deklarációs rész, középen a programtörzs területe és alul az üzenetablak, ahol többek között a hibaüzenetek jelenhetnek meg.
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5.1. ábra: A főablak felépítése
[bookmark: _Toc281762954]Változók
A CoDeSys-ban a változók a következő két módon deklarálhatóak: 
a., egyszerűen a változók begépelésével:
VAR és END_VAR között soronként:
<változónév>:<VÁLTOZÓTÍPUS>; 
b., táblázatos formában a „Project→Options→Editor” kiválasztása után a „Declarations as tables” bejelölésével.
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5.2. ábra: Változók deklarálása táblázatos formában

A program írása közben, ha a szerkesztő még nem ismert névvel vagy azonosítóval találkozik, akkor egy változó deklaráló ablak jelenik meg, rákérdezve a változó paramétereire. Ez a változó definiáló ablak a Shift+F2 billentyűk lenyomásával bármikor előhívható.
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5.3 ábra: Változó deklarálására szolgáló előugró ablak

Programozás közben a beviteli segédablak az F2 lenyomásával hívható elő. Így a már definiált változók, vagy az utasítások, függvények, funkcióblokkok listája jelenik meg, melyből kikereshető és beszúrható a kívánt elem. Emellett a változók deklarálásánál az adattípus kiválasztásához is használható.
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5.4 ábra: A beviteli segéd ablak
Az CoDeSys megkülönböztet lokális és globális, valamint Input, Output és InOut típusú változókat. A lokális változók csak az adott alprogramban, míg a globális változók a teljes projekten belül érvényesek. A „Resources” lap „Global Variables” könyvtárában található a globális változók listája. Az Input a be-, az Output a kimeneti változókat jelenti, az InOut pedig a be-kimeneti típusú változókat, melyek kezelése pointerekkel történik, ezért egy funkcióblokk InOut típusú változója kívülről nem olvasható vagy írható közvetlenül.

[bookmark: _Toc281762955]Programozási nyelvek
Az CoDeSys támogat minden, az IEC61131-3 [4] szerinti szabványos programozási nyelvet.
Szöveges programozási nyelvek: 
IL: Instruction List (utasításlista)
ST: Structured Text (strukturált szöveg)
Grafikus programozási nyelvek:
SFC: Sequential Function Chart (sorrendi folyamatábra)
FBD: Function Block Diagram (funkcióblokk)
CFC: Continuous Function Chart
LD: Ladder Diagram (létradiagram)
A CFC nyelv a funkcióblokkos programozásnak egy szabadabban alkalmazható változata. Közvetlen visszakötések alkalmazhatóak benne, egy-egy hálózatnak több kimenete is lehet, ezen kívül programrészekből makrók hozhatók létre, valamint a műveletek végrehajtási sorrendje szabadon megválasztható.
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5.5 ábra: Egy CFC nyelvű program

[bookmark: _Toc281762956]POU-k (Program Organizációs Egységek, alprogramok
Egy projektben a főprogram mellett lehetnek különböző programok, függvények vagy funkcióblokkok, amelyeket meg lehet hívni, például egy többször előforduló művelet elvégzése céljából. Ezek a „Program Organization Unit”-ok, a POU-k. Rendelkezésre állnak előre megírt, szabványos POU-k is, melyek könyvtárakból hívhatóak meg.
Új POU létrehozása a „Project→Object→Add” menüpont választásával lehetséges, ahol meg kell adni a POU nevét, típusát és programozási nyelvét.
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5.6. ábra: Új POU létrehozása

Ne felejtsük el a megírt program egységeket meghívni a főprogramból, hogy az üzemelés/tesztelés során végrehajtásukra sor kerüljön!

[bookmark: _Toc281762957]Funkcióblokk (Function Block)
Funkcióblokkok fejrészében megadandóak a be- és kimeneti, illetve a belső változók. Kívülről viszont csak a be- és kimeneti változók hozzáférhetőek. Az „InOut” típusú változók kezelése pointerekkel történik, így azokhoz kívülről közvetlenül nem rendelhető konstans érték.
Funkcióblokk hívása programból, vagy másik funkcióblokkból történhet. Ehhez az adott program fejrészében definiálni kell a funkcióblokknak egy példányát, majd a programtörzsben ennek a bemeneteihez kell hozzárendelni a kívánt adatokat. A be- és kimeneti változók a következőképpen érhetőek el: <példánynév>.<változónév>
A 5.5. ábrán egy ST nyelven írt funkcióblokk látható, mely egy be- és egy kimenettel rendelkezik. A kimenet akkor lesz „TRUE”(igaz) ha a bemenet legalább 5 másodpercig „TRUE”.
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5.7 ábra: Példa egy ST nyelven írt funkcióblokkra

[bookmark: _Toc281762958]Program

A programok olyan, globálisan értelmezett meghívható egységek, melyek megőrzik a változóik értékét a következő futásig. Egy programnak nem léteznek példányai, bármely POU-ból meghívva ugyanazok a változó-értékek láthatóak. Függvényből nem hívható meg program, de programból hívható bármely POU típus.
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5.8 ábra: Példa egy ST nyelven írt programra

A 5.8. ábrán látható egy rövid program, mely minden híváskor hozzáad egyet az „a” változó értékéhez mindaddig amíg „a>b”,mert különben az „a” értéke lenullázódik és kezdődik minden elölről.
A PLC_PRG egy olyan program, melynek létrehozását a CoDeSys egy új projekt készítésekor automatikusan felajánlja. Ezt az alapbeállítást nem szabad megváltoztatni, mert egytaszkos konfiguráció esetén ez lesz a főprogram. A PLC_PRG egy ciklus során egyszer fut le és ebből kell meghívni a végrehajtandó alprogramokat, POU-kat.

[bookmark: _Toc281762959]Könyvtárak kezelése
A projekthez számos könyvtár rendelhető, melyekben lévő POU-k, adattípusok és globális változók felhasználhatóak a projekt elkészítéséhez, hasonlóan, mint a programozó által definiált elemek. A „standard.lib” és a „util.lib” könyvtárak mindig rendelkezésre állnak, ezek részei a CoDeSys-nek. Ezekben megtalálhatóak az IEC61131-3 [] szerinti szabványos POU-k (időzítők, számlálók, szabályozók, matematikai funkciók, stb.), de hasonló könyvtárak alkalmazhatóak a PLC-vel való kommunikációhoz is.
A „Window → Library Manager” menüponttal hívható elő a könyvtárkezelő ablak. Könyvtárat csatolni a projekthez ezután az „Insert → Additional Library” választásával lehet. Ekkor meg kell nyitni a keresett könyvtárat, amelyből a kívánt elemek felhasználhatóak a projektben.
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5.9 ábra: Library Manager
Ha egy elkészült és leellenőrzött, hibátlan projekt elemeit később fel szeretné használni egy másik projektben, akkor elmentheti a projektet *.lib fájlként a „File → Save as” alatt, a megfelelő fájltípus kiválasztásával (pl. „Internal library (*.lib)” ).
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5.10 ábra: A projekt elmenthető *.lib kiterjesztéssel

Ezen kívül lehetőség van a projekt kiválasztott elemeinek exportálására, így például egyes POU-kat egyszerűen felhasználhatóvá lehet tenni más projekt számára. A „Project → Export” pont segítségével kiválaszthatóak az exportálni kívánt elemek, melyek egy *.exp kiterjesztésű fájlba lesznek letárolva. Importálásuk a „Project → Import” ponttal lehetséges.
[bookmark: _Toc281762960]Tesztelés, hibakeresés és üzembe helyezés, általános online funkciók
A CoDeSys-ben számos funkció segíti a programok tesztelését, ezen kívül beépített szimulátorral is rendelkezik, mely segítségével PLC csatlakoztatása nélkül is futtathatóak a megírt programok.
Első lépésként a forrásnyelvi programot le kell fordítani gépi kódra. Ezt a „Project → Build” (F11) vagy a „Project → Rebuild all” utasítással lehet megtenni az előbbi esetben csak a változtatások lesznek lefordítva, utóbbi esetben a teljes projekt. Amennyiben a programot rögtön tesztelni is szeretnénk, érdemes az „Online → Login” utasítást választani, mely magában foglalja a fordítást is.
Ehhez azonban el kell dönteni, hogy szimulálni szeretnénk-e a programot „Online → Simulation Mode” legyen bejelölve, vagy pedig a célhardverre letölteni. Utóbbihoz a PLC konfigurációt el kell végezni és a kommunikációs paramétereket be kell állítani a következőképpen:„Online → Communication Parameters”.
A fordítás során keletkezett figyelmeztetések, hibaüzenetek az üzenetablakban követhetőek nyomon. A hibaüzenetre való dupla kattintással lehet a programban a hiba helyére ugrani.
Az F4 megnyomásával a kurzor a lista következő hibaüzenetére ugrik.
Ha nem kapott hibaüzenetet, akkor a projektet sikerült lefordítani és áttölteni a kiválasztott hardverre, vagy a CoDeSys szimulációjába.
[image: ]
5.11 ábra: A program online módban

Látható, hogy online módban az ablak felső (deklarációs) részében, valamint a középső részben, a programtörzs mellett megjelentek a változók aktuális értékei. Ezután a program tényleges futtatása az „Online → Run” (F5) paranccsal indítható.

[bookmark: _Toc281762961]Monitorozás, változók értékének módosítása
A változók aktuális értékei nemcsak nyomon követhetőek, hanem a változóra való dupla kattintással módosíthatóak is: BOOL típusú változóra kattintva az értéke a negáltjára változik, más változók esetén pedig egy párbeszédablak jelenik meg, melyben megadható az új érték. Ekkor megjelenik a változó új értéke a régi mellett. Ezután az „Online → Write Values” (Ctrl+F7) paranccsal egy programfutási ciklus erejéig a folyamatba letölthetőek a beállított új értékek.
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5.12 ábra: Monitorozás, változó értékének módosítása

Az F7 használata („Online → Force Values”) az adott változó állandósult beállítását okozza (forszírozás), ezért ez a funkció alapvetően csak szimulációs módban ajánlott. A forszírozás kikapcsolása az „Online → Release Force” (Shift+F7) paranccsal lehetséges. Az „Online → Reset” parancs a kezdeti értékekre állítja vissza a változókat.

[bookmark: _Toc281762962]Töréspont beszúrása, lépésenkénti programvégrehajtás
A sort jelölő szürke számra való egyszerű kattintás, vagy az „Online → Toggle Breakpoint” (F9) választása a kurzor aktuális pozíciója szerinti sorban, töréspontot helyez el a programban, azaz az XControl megállítja a program végrehajtását, ha az adott sorhoz ér. Ez a funkció használható, ha a végrehajtás során adott pontban ellenőrizni kívánja a változók aktuális állapotát.
A program indítható lépésenként „Online → Step in” (F8) vagy „Step over”(F10), vagy egyedi ciklusonként („Online → Single Cycle”). Lépésenkénti végrehajtásnál, ha az adott utasítás egy POU meghívását jelenti, akkor a „Step in” végrehajtja az elágazást és megáll, míg a „Step over” nemcsak a hívást, hanem a teljes POU-t is végrehajtja ebben a lépésben.
A töréspontok szintén megállítják a programfutást az XControl-on belül is, nemcsak a szimulációs módban! Az összes változó befagyasztja az aktuális állapotát, sőt a fizikai kimeneteket is, amely adott esetben veszélyhelyzetet jelenthet mind a gépre, mind az emberi egészségre.
Az „Online → Display Flow Control” funkció bekapcsolása esetén minden, az előző PLC ciklusban végrehajtott programsor megjelölésre kerül, a sort jelölő szám zöldre vált. Ezen kívül további értékmezők jelennek meg, melyek segítik az információáramlás nyomon követését.
Az „Online → Sourcecode download” utasítás segítségével letölthető a PLC-be a forrásnyelvi program, ami nem tévesztendő össze a lefordított, gépi kódú programmal. Ezt a funkciót mindenképpen érdemes igénybe venni, ha olyan projektről van szó, amelynél valószínűsíthető, hogy helyszíni programmódosításra sor fog kerülni a jövőben . A funkcióval kapcsolatos beállítások a „Project → Options → Source download” pont alatt érhetőek el.
Az „Online → Create boot project” menüpont segítségével olyan projektet lehet létrehozni a PLC-n, amely újraindításkor automatikusan betöltődik.
Az online módban futó programok végrehajtását az „Online → Stop” utasítással lehet megszakítani, offline módba visszatérni pedig az „Online → Logout” paranccsal lehet.

[bookmark: _Toc281762963]Target settings
A célhardverrel kapcsolatos beállítások a „Resources” lapon a „Target settings” pont kiválasztásával érhetőek el. Új projekt létrehozásakor ugyanez a felület jelenik meg.
A „Configuration” mezőben listából kell kiválasztani azt a központi egységet, amelyre a projektet el szeretné készíteni. Amennyiben a keresett hardver nem szerepel a listában, az azt jelenti, hogy a hozzá tartozó „Target Support Package”, tehát az adott hardver információit tartalmazó fájlok nincsenek telepítve. Ennek telepítéséhez használja az InstallTarget alkalmazást.
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5.13. ábra: Target Settings ablak

A hardver kiválasztása után a fülekre való kattintással beállíthatóak az eszköz jellemzői: platform-beállítások „Target Platform”, memóriával kapcsolatos jellemzők „Memory Layout”, általános „General”, hálózati „Network functionality” és megjelenítési „Visualisation” beállítások.

[bookmark: _Toc281762964]Vizualizáció
Először is tesztelési és kommunikációs célokra, de a gépek és rendszerek megjelenítésére is kiválóan alkalmas a CoDeSys-be beépített vizualizációs alkalmazás.
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5.14. ábra: A vizualizációs szerkesztő

A vizualizációs szerkesztőt a „Visualizations” lapról érhetjük el. Új vizualizációt a „Project → Object →Add” menüponttal lehet létrehozni. Fontos, hogy az első vizualizációs lapnak a neve „plc_visu” legyen. Ez azért fontos, mert a PLC induláskor ezt az oldalt tölti be először. Ezután különböző megjelenítési objektumok közül választhatunk a kép összeállításához. Természetesen külső fájlból is be lehet illeszteni más szerkesztőben elkészült képet, illetve grafikát vagy fényképet. Az elemek ezután egyszerűen elhelyezhetőek, pozícionálhatóak a már ismert szerkesztő szoftverekhez hasonlóan.
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5.15 ábra: Az objektum tulajdonságainak beállítása

Az objektumra való dupla kattintással állíthatóak be a tulajdonságok. Definiálható felirat, grafika, változó hozzárendelés a kiválasztott objektumhoz, és további jellemzők is megadhatóak.
Nyomógomb definiálásakor lényegesek az „Input” kategória beállításai. Itt deklarálhatja a nyomógombhoz hozzárendelt változó viselkedését, vagy bármely más műveletet, melyet a gombra való kattintással kezdeményez.
„Toggle variable” jelentése: amint a gombra kattint, a társított bool változó állapotát váltja át állandósult módon, hasonlóan a kapcsolókhoz.
„Tap variable” esetén a gomb nyomógombszerűen működik, azaz csak addig ad jelet, amíg a gombot működteti.
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5.16 ábra: Az „Input” kategória beállításai

A változó hozzárendelés legegyszerűbben a beviteli segéddel (F2) valósítható meg. Segítségével kiválasztható egy, a projektben már definiált változó, ezen kívül gondoskodik a helyes megnevezésről és a korrekt útvonal betartásáról is.
A megjelenítő elemek konfigurálásánál alapvetően három tulajdonságnak van speciális jelentősége. Először az elemre való dupla kattintással a „Variables” kategóriának. Itt beállítható, hogy az elem hogyan reagáljon a társított bool változó állapotának, vagy a kifejezés eredményének megváltozására.
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5.17. ábra: A „Variables” kategória beállításai

Amennyiben a „Variables → Change color” mezőben megadott változó értéke FALSE, akkor a „Colors → Color” kategóriában megadott színnel jeleníti meg az objektumot. Ha a változó állapota TRUE, az „Alarm color” alatt megadott színbeállítás fog érvényesülni.
A „Variables → Invisible” mezőben megadott változó állapotától függően pedig az objektum megjelenik (FALSE), vagy eltűnik (TRUE).
[image: ]
5.18 ábra: A „Colors” kategória beállításai

Ha pedig egy változó értékét akarjuk kiíratni, a „Variables → Textdisplay” sorban kell megadni a változó nevét és a „Text” pont alatt a „Content” mezőben pedig a feliratot, valamint egy „%s” formátumú utalást a változóra.
Ha végül újra futtatja a programot az „Online → Login” és „Online → Run” parancsokkal a vezérlőn, vagy a szimulációban, akkor tesztelheti és megjelenítheti a program műveleteit egyszerű egérkattintásokkal.
Így megfigyelheti a program változóinak állapotait közvetlenül a vizualizációval egybekötve is.
[image: ]
5.19 ábra: Online módban a vizualizáció és a változók állapota


[bookmark: _Toc281762965]ÉPÜLETVEZÉRLŐ PROGRAMOK

Szakdolgozatom ezen fejezetében bemutatom az általam megírt és tesztelt épületvezérlő programokat. A programokhoz vizualizációkat is készítettem, melyekkel az internetes vezérelhetőséget kívántam megkönnyíteni.
[bookmark: _Toc281762966]Világítás vezérlés
Világításvezérlésnél a dimmelést mutatom be, mert ehhez képest a többi világításvezérlés jóval egyszerűbb. Ennek a programnak az a feladata, hogy lakóhelyiségünk lámpáinknak a fényerejét tetszőlegesen tudjuk szabályozni, mind otthon, mind pl. a munkahelyünkről interneten keresztül. Ahhoz, hogy ezt meg tudjuk oldani, szükségünk van minden fényforráshoz egy elektronikus előtétre (6.1.1 ábra), amelynek a vezérlő feszültsége 0-10 VDC. Többfajta vezérlő feszültségű elektronika létezik, de nekünk a 0-10 VDC felel meg, mert a PLC analóg kimenetén ezt tudja kiadni. Az elektronika a vezérlő fezültség függvényében állítja a kimeneti feszültégét, amelyet a fényforrásunk kap meg. A 6.1.2 ábrán mutatom be a mérés blokkvázlatát és a 6.1.3 ábrán pedig a mérés megvalósítását.
 (
Vezérlő bemenet:
0-10V
DC
Hálózati 
f
e
szült
s
ég:230V
Elektronikus előtét
Fénycső:
0-230V
AC
)
6.1.1 ábra: Előtét elektronika blokk vázlata
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6.1.2 ábra: A világítás vezérlés blokk vázlata

[image: ]
6.1.3 ábra: A világításvezérlés megvalósítva
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A következő program a PLC_PRG fülbe kell beírni, ami a dimmelést fogja végezni: 
PROGRAM PLC_PRG
VAR
	dimmeles_fel1:R_TRIG;
	dimmeles_le1:R_TRIG;
	dimmeles_fel2:R_TRIG;
	dimmeles_le2:R_TRIG;
	a: BOOL;
	b: BOOL;
	szinkeveres: REAL;
	szin: DWORD;
	c: BOOL;
	d: BOOL;
	e: BOOL;
	f: BOOL;
END_VAR
VAR_INPUT
	sarga: UINT;
END_VAR
(*Az első rész az inicializálás, amiben a különböző változókat kell megadni és azok típusát.*)
dimmeles_fel1(CLK:=be1 , Q=>a );
		IF a=TRUE THEN
			IF ki3<32000 THEN
				ki3:=ki3+2000;
				sarga:=sarga+15;
			END_IF
		END_IF
(*Az második rész a dimmelés_fel1, amiben a felfelé dimmelést és a világosodó színkeverést végezzük.*)
dimmeles_le1(CLK:=be2 , Q=>b );
		IF b=TRUE THEN
			IF ki3>0 THEN
				ki3:=ki3-2000;
				sarga:=sarga-15;
			END_IF
		END_IF
(*Az harmadik rész a dimmelés_le1, amiben a lefelé dimmelést és a sötétedő színkeverést végezzük.*)
dimmeles_fel2(CLK:=c , Q=>e );
		IF e=TRUE THEN
			IF ki3<32000 THEN
				ki3:=ki3+2000;
				sarga:=sarga+15;
			END_IF
		END_IF
(*Az negyedik rész a dimmelés_fel2, amiben a felfelé dimmelést és a világosodó színkeverést végezzük a programban. Ezzel a résszel oldjuk meg a webes dimmelést.*)
dimmeles_le2(CLK:=d , Q=>f );
		IF f=TRUE THEN
			IF ki3>0 THEN
				ki3:=ki3-2000;
				sarga:=sarga-15;
			END_IF
		END_IF
(*Az ötödik rész a dimmelés_le2, amiben a lefelé dimmelést és a sötétedő színkeverést végezzük a programban. Ezzel a résszel oldjuk meg a webes dimmelést.*)
szin:=sarga+sarga*256;
(*A hatodik rész a szín, amiben a színkeverést végezzük.*)
A programot úgy írtam meg, hogy van két nyomógombunk: a „dimmelés fel” és a „dimmelés le”. E két nyomógombnak figyeljük a felfelé való él váltását. Azért csak az él váltást figyeljük, mert ha nem, akkor a nyomógombot nyomva tartva folyamatos dimmelést érnénk el. Az él figyeléssel minden egyes nyomógomb megnyomása után egy adott lépcsővel növekszik a fényforrásunk fényereje. A lépcsőzést olyan mértékűre állíthatjuk, amire szeretnénk. Kis lépcsőzés beállításával pontos fényerőséget is be tudunk állítani.
Ami még figyelemre méltó a programban az az, hogy egy színkeverést is beleraktam, ami az adott fényforrás dimmelése távolról, akár az irodánkból interneten való vezérlésnél is nyomon követhető legyen.

[bookmark: _Toc281762968]Vizualizáció
Az alsó füleken kattintsunk a „Vizualization” fülre! Baloldalt a „Vizualization mappára jobb kattintás→Add Objekt…” hozzunk létre egy új kezelőfelületet, aminek a neve „plc_visu” legyen. Majd a jobb oldalon megkezdhetjük a munkát.
Rajzoljunk két kört és színezzük, illetve írjuk rá a megfelelő feliratokat!
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6.1.4 ábra: A dimmelő gombok megrajzolása

Természetesen olyan alakot és színt választhatunk a gomboknak, amilyent a sokféle lehetőség biztosít számunkra. Az alakzatokra kétszer kattintva hívhatjuk elő a beállítási felületet. A gombokon a következő beállításokat hajtsuk végre:
[image: ]
6.1.5 ábra: A „Dimmelés_FEL” gomb beállítása.
[image: ]
6.1.6 ábra: A „Dimmelés_LE” gomb beállítása.

Majd rajzoljunk egy másik alakzatot, amin a fényerősséget tudjuk nyomon követni. Ezen az alakzaton szintén végezzük el a szükséges beállításokat.
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6.1.7 ábra: A világításfigyelő felirata.
[image: ]
6.1.8 ábra: A világításfigyelő színkeverésének beállítása.

[image: ]
6.1.9 ábra: A világításfigyelő értékének kiíratása.
[image: ]
6.1.10 ábra: A világításvezérlő vizuális megjelenése.

Az „Online→Simulation Mode” parancsot adjuk ki! Az „Online→Login” majd az „Online→Run” paranccsal tudjuk leszimulálni a programunk működését.

[bookmark: _Toc281762969]Hűtés-Fűtés vezérlés
Ebben a fejezetben a hűtés-fűtés vezérlését mutatom be. A hétköznapi háztartásokban egyre inkább elterjedőben vannak a klímák, így ez ma már nem csak a gazdagok igénye. Manapság már az is igény, hogy otthonunkat nem csak helyben, hanem akár a világ másik végéről is felügyelni tudjuk. Ebben ez a rendszer is segítségünkre van. A PLC rendszer a kétlábú PT-100-as hőmérséklet érzékelővel kompatibilis. A rendszer úgy működik, hogy első bekapcsoláskor alapbeállításként felvesz alap hőmérséklet értékeket és távolléti üzemmódban fut a program. Tápellátás kimaradása esetén is az alapbeállítás értékeket veszi fel és távolléti üzemmódban fut. A távolléti üzemmódban a klíma le van tiltva és a beállított hőfok 7-12°C. Normál üzemmódban a beállított hőfok 18-22°C, hűtés esetén 28-32°C. Természetesen a rendszer engedi, hogy ezeket az értékeket manuálisan is változtathassuk, az érzékenyebb felhasználók számára. Azért fontos, hogy a távolléti üzemmódban indítsuk a rendszert, mert ha télen van a tápkimaradás és nem vagyunk otthon, akkor ne fűtsük feleslegesen a házat. Nyáron ugyan ez a helyzet, ne hűtsük feleslegesen a házat. Interneten keresztül is vezérelhetjük a rendszert, ahol még az aktuális hőfokot is láthatjuk.
A következő ábra a hűtés-fűtési rendszer működését mutatja be normál üzemmódban. A fűtés 22°C-nál kapcsol be és 18°C-nál kapcsol ki. A hűtés 32°C-nál kapcsol be és 28°C-nál kapcsol ki.
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6.2.1 ábra: A hűtés-fűtési rendszer működése
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6.2.2 ábra: A hűtés-fűtési rendszer megvalósítva
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A következő program a PLC_PRG fülbe kell beírni, ami a hűtés-fűtés vezérlését fogja végezni: 
PROGRAM PLC_PRG
VAR
a: INT;
	b: INT;
	c: INT;
	d: INT;
	e: INT;
	f: INT;
g: INT;
	h: INT;
	i: INT;
	j: BOOL;
	k: INT;
	l: BOOL;
	m: BOOL;
	n: BOOL;
	t1: INT;
	t2: INT;
	n1: INT;
	n2: INT;
	o: BOOL;
	n4: INT;
	szin1: BOOL;
	szin2: BOOL;
END_VAR
(*Az első rész az inicializálás, amiben a különböző változókat kell megadni és azok típusát.*)
VAR_INPUT
	n3: INT;
END_VAR
IF j=0 OR be2=TRUE  THEN
		t1:=7;
		t2:=12;
		n1:=18;
		n2:=22;
		n3:=32;
		n4:=28;
		a:=7;
		b:=12;
		c:=32;
		d:=28;
		j:=1;
		k:=0;
ELSE
		e:=a*10;
		f:=b*10;
		g:=c*10;
		h:=d*10;
END_IF
(*A második rész a hőmérséklet alap beállítására szolgál és azok 10-el való szorzását végzi el a program. A szorzás azért szükséges, mert a hőmérsékletérzékelőnk is az adott hőmérséklet 10-el való szorzását érzékeli. Tehát a 23,4°C-ot a PLC bemenetén 234-nek érzékeli. A „j” változó azért szükséges, hogy az alapbeállítás rész csak egyszer fusson le. A „k” változóval állítom be, hogy a távolléti üzemmódban indítsuk a rendszert és áramszünet után a PLC szintén távolléti üzemmódban fog futni.*)

IF n=TRUE AND k=0 THEN
szin1:=TRUE;
	t1:=a;
	t2:=b;
ELSE
		szin1:=FALSE;
END_IF

IF n=TRUE AND k=1  THEN
		szin2:=TRUE;
		n1:=a;
		n2:=b;
		n3:=c;
		n4:=d;
ELSE
		szin2:=FALSE;
END_IF
(*A harmadik rész a „Mentés” gomb beállításait tartalmazza. Ezzel a funkcióval tudunk új hőmérséklet beállításokat megadni és azokat elmenteni. A program újraindulásakor ezek a hőmérséklet beállítások elvesznek és az alapbeállítások lépnek érvénybe.*)

IF be1=TRUE OR l=TRUE  THEN
	a:=t1;
	b:=t2;
	k:=0;
END_IF
(*A negyedik rész a távolléti üzemmód hőmérséklet beállítását tartalmazza.*)
IF be2=TRUE OR m=TRUE  THEN
	a:=n1;
	b:=n2;
	c:=n3;
	d:=n4;
	k:=1;
END_IF
(*Az ötödik rész a normál üzemmód hőmérséklet beállítását tartalmazza.*)
i:=be3/10;
(*Ez a rész csak a szimulációhoz volt szükséges. Ezzel szimuláltam a hőfokérzékelőt, de a program futása közben a hőfok tízzel való szorzását is kimutatja.*)
IF be3<e THEN
	ki1:=TRUE;
END_IF
IF be3>f THEN
	ki1:=FALSE;
END_IF
(*Az hatodik rész a fűtésvezérlés.*)
IF be3>g AND k=1 THEN
	ki2:=TRUE;
END_IF
IF be3<h OR k=0 THEN
	ki2:=FALSE;
END_IF
(*A hetedik rész a hűtésvezérlés.*)

[bookmark: _Toc281762971]Vizualizáció
Az alsó füleken kattintsunk a „Vizualization” fülre! Baloldalt a „Vizualization mappára jobb kattintás→Add Objekt…” hozzunk létre egy új kezelőfelületet, aminek a neve „plc_visu” legyen. Majd a jobb oldalon megkezdhetjük a munkát.
Rajzoljunk négy téglalapot egymás alá majd a következő ábra szerint feliratozzuk és színezzük!
[image: ]
6.2.3 ábra: A hőmérséklet beállítások megjelenése

A gombokat a következő beállításokkal lássuk el!
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6.2.4 ábra: A fűtés bekapcsolásának bemenő értéke

A következő ábra mind a négy alakzatnak a beállítása kell, hogy legyen. Ezzel a beállítással érjük el azt, hogy mi is meg tudjuk adni hőmérséklet értékeket.
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6.2.5 ábra: Az értékek megadása
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6.2.6 ábra: A fűtés kikapcsolásának bemenő értéke
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6.2.7 ábra: A hűtés bekapcsolásának bemenő értéke
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6.2.8 ábra: A hűtés bekapcsolásának bemenő értéke

Majd rajzoljunk két kört, amely két vezérlési módot fogja irányítani és lássuk el a megfelelő színekkel!
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6.2.9 ábra: A vezérlő gombok
A színbeállításoknál az „Alarm color”-t válasszuk zöldnek! Ezzel biztosítjuk azt, hogy amelyik mód éppen üzemben van, az zöld lesz. Erre a két gombra a következő beállítások érvényesek:
[image: ]
6.2.10 ábra: A „Távolléti” gomb színváltása
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6.2.11 ábra: A „Távolléti” gomb bemenete
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6.2.12 ábra: A „Normál” gomb színváltása

[image: ]
6.2.13 ábra: A „Normál” gomb bemenete

Majd rajzoljunk még két alakzatot, amelyek a fűtés illetve a hűtés működését fogja megjeleníteni!
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6.2.14 ábra: A fűtés/hűtés megjelenítése
A színbeállításoknál az „Alarm color”-t válasszuk pirosnak, (fűtés) illetve kéknek (hűtés)! Ezzel biztosítjuk azt, hogy amelyik rendszer éppen üzemben van, annak változni fog a színe. Erre a két alakzatra a következő beállítások érvényesek:
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6.2.15 ábra: A fűtés beállítása
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6.2.16 ábra: A hűtés beállítása

Majd végezetül rajzoljuk meg a hőmérőt, amelyet a jobb felső részben lévő „Bar display” gombbal tudunk megrajzolni.
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6.2.17 ábra: A hőmérő megjelenítése
A hőmérőn a következő beállításokat végezzük el.
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6.2.18 ábra: A hőmérő beállításai

A „Variable/Scale” gombot megnyomva még több beállítást végezhetünk.
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6.2.19 ábra: A hőmérő bemenete
A narancssárga alakzat a hőmérséklet szimulációjára szolgál.
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6.2.20 ábra: A hőmérő szimulátor bemenete
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6.2.21 ábra: A hőmérő szimulátor bemenetének változtatása

Ahhoz, hogy a felhasználó a beállított hőmérsékleteket megtartsa, szükségünk van egy mentés gombra. A program futása közben az éppen üzemelő módban tudunk új hőmérsékletet beírni és a mentés gombbal azt el is tudjuk menteni.
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6.2.22 ábra: A „Mentés” gomb

Ezt a gombot a következő beállításokkal lássuk el.
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6.2.23 ábra: A „Mentés” gomb színváltása
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6.2.24 ábra: A „Mentés” gomb típusa
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6.2.25 ábra: A hűtés/fűtés vizuális megjelenítése
Az „Online→Simulation Mode” parancsot adjuk ki! Az „Online→Login” majd az „Online→Run” paranccsal tudjuk leszimulálni a programunk működését
[bookmark: _Toc281762972]Árnyékolás vezérlés
Manapság otthonunk ezen funkciója sem elhanyagolható, mivel senki sem szeret verőfényes napsütésben filmet nézni, illetve személyes magánéletét kitárni az utcán járók elé az esti órákban. A PLC ezt a problémánkat is megoldja számunkra. Az egyik legérzékenyebb pontja a rendszernek a fényerősség érzékelő, aminek a kimenete szintén 0-10VDC kell, hogy legyen. Az ilyen fényérzékelőket a boltokban is megvásárolhatjuk, de annak az árát nagyon magasnak találtam.(33.000Ft+áfa/db), ezért saját magam összeraktam egy viszonylag olcsóbb eszközt.(1000Ft). A feladatot egy fotóellenállás segítségével oldottam meg, amely egy feszültségosztóban kapott helyet.
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6.3.1 ábra: A fényérzékelő kapcsolási rajza
[image: ]
6.3.2 ábra: A fényérzékelő megvalósítva
Az érzékelő bemeneti feszültségét azért 24VDC-re választottam, mert a PLC tápfeszültsége is ennyi, így nem kell új tápfeszültséget előállítanom. Az érzékelő kimeneti feszültségét egy Zener dióda segítségével maximalizáltam 10VDC-ra. A kimeneti fezültséget egy 150kΩ-os ellenállásról veszem ki, mert így tudom azt elérni, hogy sötététben kis feszültséget, világosban pedig nagy feszültséget kapjak a kimeneten. Mellékesen megjegyzem, hogy fordítva is működik a fényérzékelő. Miután beállítottuk a kívánt fényerősséget, a program létrehoz magának egy sávot, amiben nem dolgozik a rendszer. Ez azért szükséges, mert pontos fényerőséget nem tudunk beállítani és kis fényerő változás hatására ne húzza fel-le a redőnyt a program. Kellemetlen lenne, ha filmnézés közben egy változóan felhős napon fel-le mozogna a redőny 5 másodpercenként.
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6.3.3 ábra: Az árnyékolási rendszer működése
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6.3.4 ábra: Az árnyékolási rendszer megvalósítása
Szerepet kap még a feladatban két végállás kapcsoló, amelyek a redőny helyzetét követik nyomon. Ez a rendszer csak a redőny végállását tudja jelezni, közbenső állást nem. Ezt két kapcsolóval helyettesítettem.
Három fajta üzemmódot mutatok be:
-Mozi mód
-Alvó mód
-Kézi mód
A mozi és az alvó üzemmódban a fényerősséget a program állítja be magának és automatikusan állítja a redőny helyzetét, de utólag ezek az értékek tetszőlegesen változtathatók. A kézi üzemmódban saját magunk állíthatjuk be a redőny helyzetét nyomógombok segítségével és az automatikus üzemmódokat tiltjuk. Tehát ha kézileg állítjuk be a redőnyt, akkor a PLC nem fogja utólag állítani a helyzetét mindaddig, amíg át nem kapcsolunk egy másik üzemmódba.
[bookmark: _Toc281762973]A Program
A következő program a PLC_PRG fülbe kell beírni, ami az árnyékolás vezérlését fogja végezni:
PROGRAM PLC_PRG
VAR
PROGRAM PLC_PRG
VAR
	c: INT;
	d: INT;
	a: BOOL;
	b: BOOL;
	e: INT;
	f: BOOL;
	g: BOOL;
	j: INT;
	h: BOOL;
	i: BOOL;
	k: BOOL;
	l: BOOL;
	m: INT;
	n: INT;
END_VAREND_VAR
(*Az első rész az inicializálás, amiben a különböző változókat kell megadni és azok típusát.*)
IF j=0 THEN
n:=50;
j:=1;
END_IF
c:=e+1600;
d:=e-1600;
m:=be7/320;
e:=n*320;
(*A második rész az alap fényerősség beállítást végzi. A „j” változó azért szükséges, hogy a program csak egyszer végezze el az alapbeállítást. A „c” és a „d” változó a fényerősség sáv kialakításában játszik szerepet. Az „m” és az „e” változó fényerősség kijelzésére és bevitelére szolgálnak.*)
IF f=TRUE THEN
	n:=20;
	h:=TRUE;
	i:=FALSE;
	l:=FALSE;
END_IF
(*A harmadik rész a mozi vezérlés.*)

IF g=TRUE THEN
	n:=5;
	i:=TRUE;
	h:=FALSE;
	l:=FALSE;
END_IF
(*A negyedik rész az alvó vezérlés.*)

IF k=TRUE THEN
	l:=TRUE;
	i:=FALSE;
	h:=FALSE;
END_IF
(*Az ötödik rész a kézi vezérlés.*)

IF be7>c AND be2=FALSE AND l=FALSE THEN
		ki2:=TRUE;
ELSE
		ki2:=FALSE;
END_IF
(*Az hatodik rész az automatikus redőny „fel vezérlés”.*)
IF be7<d AND be1=FALSE AND l=FALSE THEN
		ki1:=TRUE;
ELSE
		ki1:=FALSE;
END_IF
(*Az hatodik rész az automatikus redőny „le vezérlés”.*)
IF l=TRUE THEN
	IF a=TRUE AND be2=FALSE THEN
		ki2:=TRUE;
	ELSE
		ki2:=FALSE;
	END_IF
END_IF

IF l=TRUE THEN
	IF b=TRUE AND be1=FALSE THEN
		ki1:=TRUE;
	ELSE
		ki1:=FALSE;
	END_IF
END_IF (*Az hetedik rész a „kézi vezérlés” weben keresztül.*)


[bookmark: _Toc281762974]Vizualizáció
Az alsó füleken kattintsunk a „Vizualization” fülre! Baloldalt a „Vizualization mappára jobb kattintás→Add Objekt…” hozzunk létre egy új kezelőfelületet, aminek a neve „plc_visu” legyen. Majd a jobb oldalon megkezdhetjük a munkát.
A lap tetejére rajzoljunk egy téglalapot, amelyet a következőképpen színezzük és feliratozzuk.
[image: ]

6.3.5 ábra: A „Fő menü” felirat

Majd ezután rajzoljunk három karikát és feliratozzuk a következőképpen.
[image: ]

6.3.6 ábra: A kezelő gombok létrehozása

A „Mozi” gombot a következő beállításokkal lássuk el.
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6.3.7 ábra: A „Mozi” gomb színváltása

[image: ]

6.3.8 ábra: A „Mozi” gomb bemenete

A „Kézi” gombot a következő beállításokkal lássuk el.
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6.3.9 ábra: A „Kézi” gomb színváltása

[image: ]

6.3.10 ábra: A „Kézi” gomb bemenete

Az „Alvó” gombot a következő beállításokkal lássuk el.
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6.3.11 ábra: Az „Alvó” gomb színváltása

[image: ]

6.3.12 ábra: Az „Alvó” gomb bemenete

A felső menüsorból válasszuk ki a „Meter” gombot és rajzoljuk meg a következő ábrát.
[image: ]

6.3.13 ábra: A fényerősségmérő

A fényerősségmérőt a következő beállításokkal lássuk el.
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6.3.14 ábra: A fényerősségmérő beállítása
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6.3.15 ábra: A fényerősségmérő skálázása

[image: ]

6.3.16 ábra: A fényerősségmérő színskálája

Majd rajzoljunk két négyzetet a következőképpen:
[image: ]

6.3.17 ábra: A végállás kapcsolók

A két érzékelőt a következő beállításokkal lássuk el.
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6.3.18 ábra: A „Fent” végállás kapcsoló beállítása

[image: ]
6.3.19 ábra: A „Lent” végállás kapcsoló beállítása

Majd baloldalt a „Vizualization mappára jobb kattintás→Add Objekt…” hozzunk létre három új kezelőfelületet, aminek a neve már tetszőleges lehet. Majd a jobb oldali ablakokba másoljuk be az eddig létrehozott alakzatokat a főmenü kivételével.
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6.3.20 ábra: Az első munkalap triplázása

A „plc_visu2” munkalapon rajzoljuk meg a következő alakzatot.
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6.3.21 ábra: A „Vissza” gomb
És a gombot a következő beállításokkal lássuk el.
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6.3.22 ábra: A „Vissza” gomb beállítása

A következő ábrákat szintén erre a munkalapra készítsük el.
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6.3.23 ábra: A „Kézi” vezérlés
A gombokat a következő beállításokkal lássuk el.
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6.3.24 ábra: A „Fel” gomb színváltozása
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6.3.25 ábra: A „Fel” gomb beállítása
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6.3.26 ábra: A „Le” gomb színváltozása
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6.3.27 ábra: A „Le” gomb beállítása

A „plc_visu3” munkalapon rajzoljuk meg a következő alakzatokat.
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6.3.28 ábra: A „Mozi” vezérlés

A „Vissza” gombot ugyanúgy állítsuk be, mint az előző munkalapon. Az új alakzatot a következő beállításokkal lássuk el.
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6.3.29 ábra: A „Fényerősség” gomb színváltozása
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6.3.30 ábra: A „Fényerősség” gomb bemenete

A „plc_visu4” munkalapon rajzoljuk meg a következő alakzatokat.

[image: ]
6.3.31 ábra: Az „Alvó” vezérlés
A „Vissza” gombot ugyanúgy állítsuk be, mint az előző munkalapon. Az új alakzatot a következő beállításokkal lássuk el.
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6.3.32 ábra: A „Fényerősség” gomb színváltozása
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6.3.33 ábra: A „Fényerősség” gomb bemenete
[image: ]
6.3.34 ábra: Az árnyékolás vizuális megjelenítése

Az „Online→Simulation Mode” parancsot adjuk ki! Az „Online→Login” majd az „Online→Run” paranccsal tudjuk leszimulálni a programunk működését


[bookmark: _Toc281762975]WEBES ELÉRHETŐSÉG

Napjainkban nagy igény, hogy otthonunkat távolról is vezérelni tudjuk. Ehhez nincs szükségünk másra, csak internetre, egy router-re és egy olyan PLC-re, amelynek van web servere. Én a Wago 750-873-as típusú PLC használtam. Ennek a PLC-nek van web servere és hálózati csatlakozási pontja. A feladatot azzal kell kezdenünk, hogy a PLC-t rákötjük a helyi hálózatra routeren keresztül. Elvileg a router ad egy ip-címet a PLC-nknek, ha ez nem történik meg, akkor az Ethernet settings programot kell elindítanunk. Ezzel a programmal tudunk a PLC-nek ip-címet adni.
[image: ]
7.1 ábra: WAGO Ethernet Settings nevű program

A „Read” gombra kattintva tudjuk a PLC-t beolvasatni.
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7.2 ábra: PLC adatai
A „TCP/IP” fülön tudjuk beállítani a PLC ip címét!
[image: ]
7.3 ábra: A PLC ip adása
Miután ezt megtettük, a szokásos módon töltsük fel a megírt programunkat a PLC-re. Ezután a Services cabel csatlakozójánál a „jumper”-t állítsuk „RUN” üzemmódba.
Majd egy internet böngészőbe írjuk be a PLC-nk ip-címét. Ekkor megnyílik a PLC vizuális ablaka, amit megírtunk a programban. Ha ez működik, akkor kimehetünk a világhálóra. A routeren állítsuk be az egyik portjára azt az ip-címet amit a PLC-nk kapott.
 [image: ]7.4 ábra: A router ip és port beállítása

A „Protocol” fülön tudjuk azt a portot beállítani, amin a PLC-t elérjük majd. A routeren is erre a portra kell állítanunk a PLC ip címét.
[image: ]
7.5 ábra: A PLC port megadása

Majd a világhálón keresztül címezzük meg a routernek azt a portját, amire beállítottuk a PLC-t. Ekkor szintén megnyílik a PLC vizuális oldala. 
[image: ]
7.6 ábra: A PLC belépő oldala
Ezen az oldalon válasszuk ki a „WebVisu” menüpontot és már irányíthatjuk is az épületfelügyelő rendszerünket.
[image: ]
7.7 ábra: A PLC vizuális oldala
Már majdnem befejeztük a feladatot, csak még egy dolog van hátra: a titkosítás. Nem örülnénk annak, ha idegenek szórakozásból, vagy egyéb megfontolásból tudnák irányítani a házunk rendszerét. Ezért ezt az internetes elérhetőséget jelszóval kell védenünk.
A PLC belső beállításában nincs jelszavas védelem. Ezt a problémát ezért más módon oldottam meg. Mikor a PLC-re rátöltjük a programot, akkor a Codesys egy html oldalt másol a célhardverre. Ennek a html kódját kell az internetes oldalra-http://www.zubrag.com/tools/html-password-protector-encoder.php - felmásolnunk és jelszó megadásával levédeni.
[image: ]
7.6 ábra: A jelszavas védelem
Majd ez az oldal egy újabb html kódot generál, amit vissza kell másolnunk a PLC-re! Ezzel a művelet sorral tudjuk levédeni a PLC-nket, de ez olyan feladat, amit egy átlag felhasználó nem tud egyedül megoldani.
[bookmark: _Toc281762976]TARTALMI ÖSSZEFOGLALÓ

Napjainkban egyre inkább terjedőben vannak az inteligens épületautomatikák. Az ezeket a rendszereket gyártó cégek összefogtak és nem engedik az árak csökkenését. Szakdolgozatomban szerettem volna egy alternatív megoldást találni erre a problémára. Olyan rendszert kerestem, amely meg tudja valósítani az épületfelügyelő-rendszerek feladatát és az ára is elfogadható. A PLC-t alkalmasnak találtam erre a feladatra.
Szakdolgozatomban bemutattam azokat az épületfelügyeleti funkciókat, amiket a hétköznapi emberek is alkalmaznának. Megjegyzem, hogy ezek a funkciók manapság már nem számítanak luxusnak. A főbb funkciók: Világításvezérlés, Hűtés-fűtésvezérlés, Árnyékolásvezérlés, Kerti világítás, Garázskapu vezérlés, Öntöző vezérlés. Ezek közül az első három példát mutattam be, mert azok a bonyolultabb feladatok. Az utolsó három pár soros programmal megoldható.
Az eszközeim kifogástalanul működtek munkám során. A programok - amiket megírtam - működtek és be is mutattam őket a konzulensemnek működés közben.
A vizualizációnál elsősorban feladat megvalósítására összpontosítottam.
A webes elérhetőségben próbáltam minden olyan módon elérni a rendszert, amit használnánk is a hétköznapokban.(PC,PDA,MOBIL) Az egyszerűbb mobilok és PDA-k nem tudták megjeleníteni a PLC webes oldalát, mert a böngészőjük nem futtat java alkalmazást. Valószínűleg a drágább termékek már képesek lesznek erre a feladatra.
A webes titkosítás még szakembert igényel. Ezt a jövőben még szeretném kiküszöbölni.
Összességében úgy gondolom, hogy a PLC-nek van helye az épületautomatizálásban, még akkor is, ha néhány hátránya is van az épületvezérlő rendszerekkel szemben.


[bookmark: _Toc281762977]SUMMARY

They are in one spreading rather continually in our Suns the inteligens building automaticses. The firms producing these systems joined forces and the decrease of the prices is not allowed. I loved in my thesis finding a solution to this problem would be an alternative one. I was looking for a system that can accomplish the task of the building inspector systems and his price affordable. The PLC what I found this task for suitable one.
I presented the building supervision functions that the everyday people_nation would apply in my thesis. I would observe that these are the functions nowadays not anymore luxury functions. The more capital functions: Lighting control, refrigeration heating control, screening control, garden lighting, garage gate control, watering control. From among these I presented the first three examples because they are the more complicated tasks. The last three are solvable with a couple of next programs.
My devices worked impeccably in the course of my work. The programs - what I wrote - they worked and I introduced them to my consultant during function.
In the visualisation no onto aesthetic I made an effort, but onto the realisation of the task. The appearance solvable aesthetically, but it already only minor matter.
I tried to reach the system, which we would use, in the web availability on all manners like that in the weekday.(PC,PDA,mobile phone) The plainer mobile phones and PDA were not able to display the web side of plc, because their browser does not run java application. The more expensive products will be capable of this task already presumably.
The encryption not yet perfect, because the system down we can make it confidential, but the programmer can do this only. The user can change his password in such a way that he tells it to the programmer and the programmer presents it as him. I would like to eliminate this yet in the future.
I believe it so in his totality, that the PLC is eligible in the building automation, even then, if more are his disadvantage the building controller is opposite systems.
[bookmark: _Toc281762978]IRODALOMJEGYZÉK
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[bookmark: _Toc281762979]MELLÉKLET
1.sz. melléklet: 750-873 Ethernet PLC
[image: ]
[image: ]
2.sz. melléklet: 750-400, Digitális bemeneti modul
[image: ]
3.sz. melléklet: 750-459, Analóg bemeneti modul
[image: ]
4.sz. melléklet: 750-460, Analóg bemeneti modul PT100-as hőmérséklet érzékelőhöz
[image: ]
5.sz. melléklet: 753-512, Digitális kimeneti modul
[image: ]
6.sz. melléklet: 753-550, Analóg kimeneti modul
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7.sz. melléklet: 750-600, Végelzáró modul
[image: ]
8.sz. melléklet: 788-304, Villamos relé modul
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